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G-Lock EasyMail7 Overview  

An effective email marketing system should include the following 
tools: 

- Automated email sequences that drip on your contacts over time 
to build trust and convert your subscribers into active and happy 
customers. 

- An email scheduler for planning your announcements, 
newsletters, and special occasion emails weeks or even months in 
advance. 

- A simple way for you to create sign-up forms so you can connect 
your marketing efforts to auto-populate your contact lists (we provide 
WPNewsman plugin for WordPress for free). 

- A professional collection of quality responsive HTML email 
templates that you can install and use for your newsletters on the fly. 

- An automated way of processing bounce and unsubscribe 
emails to be in compliance with the CAN-SPAM law in various 
countries. 

- Training and support from those who have years of experience 
in email marketing systems, management and success. 

With G-Lock EasyMail7 you have the right email marketing 
software system to help you maintain and grow your business. 

G-Lock EasyMail7 is a PRIVATE and SECURE in-house email 
marketing solution that eliminates the complexity and expense of 
operating a third-party email service. 

G-Lock EasyMail7 is built on a client-server model. The program 
consists of two components: EasyMail7 Server and EasyMail7 Client 
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with beautiful, easy to use and understand user interface. 
 

 

 

The EasyMail7 Server is installed on a local computer or a 
Windows Server 2008/2012, Amazon EC2 or Windows Azure Virtual 
Machine where you can deploy your own customized Windows Server. 
It runs as a service in the background and does most of the work: send 
out messages, check for incoming returned messages and update the 
contact lists. 

The EasyMail7 Client can be installed on as many computers as 
you want. Users login to the EasyMail7 Server from their computers 
and manage email lists and campaigns. 

Admin can create and manage users and workplaces and assign 
users to workplaces. Several users can work with one workplace 
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simultaneously. Or each user can work with his own workplace at the 
same time on the EasyMail7 Server. 

A workplace includes email server accounts, email templates and 
drafts, sent items, contact groups (internal and external lists), and 
Bounce Handler settings. Each user has the full control under his own 
workplace(s) allocated to him by admin.  

Admin can set sending limitations for the workplace such as 
monthly sending limits and maximum sending slots to control the 
server load. 

G-Lock EasyMail7 is fully integrated with Amazon SES API as 
well as with Amazon SES SMTP unlike competitors that can work with 
Amazon SMTP only. When using the Amazon SES API mode program 
automatically controls your Amazon SES account quota limitations to 
comply with Amazon SES requirements. 

You can have unlimited custom fields for email personalization in 
your contact lists and you have the capability to send to multiple 
groups simultaneously.  

 

Free Trial Version Limitations 

The free trial version of G-Lock EasyMail7 is limited to: 

- 250 messages per hour; 

- 1,000 messages per day; 

- 12,000 messages per month; 

- 14 days of use.  

After the trial period expired, the user must either buy the license 
for G-Lock EasyMail7, or discontinue using the program. 
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License Model 

G-Lock EasyMail7 license is sold as an annual subscription. This 
means that when you purchase the license, you receive 12 months of 
free updates for the EasyMail7 Server and Client from the date of your 
purchase – be it a minor program update or a major new version. Plus, 
you receive best in class support from our team.  

If you choose not to renew, you can continue using the last 
version you obtained or are eligible to use. The 12 month time frame is 
merely for new versions/updates and has no relevance to rights of use 
(as long as the EULA is not violated). 

We have built a business where our focus is on supporting our 
existing customers. By paying a small subscription fee every year you 
can be assured we will continue improving software and offering the 
best customer service in the market. 

You have unlimited features in ANY paid version. We simply 
charge a fixed price per user/workplace. We do not try and upsell you 
to more expensive licenses so you can access specific features. You 
can be assured that whatever size of business you are and whatever 
paid license you have, you will always have access to all G-Lock 
EasyMail7 features. 

G-Lock EasyMail7 is backed by a 60 day unconditional money-
back guarantee. 
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Installation 

Important! G-Lock EasyMail7 is NOT compatible with older 
versions of G-Lock EasyMail. If you have a 6.xx or 5.xx version of G-
Lock EasyMail, install G-Lock EasyMail7 to a new directory on your 
hard drive. Then you can import your contacts into G-Lock EasyMail7. 

To install G-Lock EasyMail7:  

1. Download G-Lock EasyMail7 from http://easymail7.com   

2. Extract the files from the easymail7.zip file to the temp 
directory.  

3. Run the easymail7_setup.exe file.  

4. Follow the steps of the installation process. 

Choose the EasyMail7 components that you want to install during 
the setup process. To start, install both the EasyMail7 Server and 
Client onto your personal computer or server. 
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Activation and First Run 

If the program is successfully installed, the EasyMail7 Server 
automatically starts and runs as a service on the background. 

Start G-Lock EasyMail7 Client component. On the login screen 
enter the IP address of the server where the EasyMail7 Server 
component is installed. 

If you installed the EasyMail7 Server and Client on the same 
computer, enter your computer's name, or localhost, or 127.0.0.1 into 
the "EasyMail7 Server" field. 

The port number is set automatically. The EasyMail7 Client uses 
the port 50888 to connect to the EasyMail7 Server. 

For the first login to the EasyMail7 Server use the default login 
information (user name and password are case sensitive!): 

User Name: Admin  
Password: Admin 
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Click “Connect”. 

Now you must get the key and activate the trial version of G-Lock 
EasyMail7. 

Type your first name, last name and email address on the 
activation screen and click the “Get Free Key” button. 

The message with your personal key will be sent at your email 
address so make sure you entered a valid email address. 

 

 

Copy-paste your key on the activation screen.  

Click “Activate”. 
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After the activation the program will ask you to change the default 
password to protect your G-Lock EasyMail7 data from an unauthorized 
access. 

 

 

Type your new password on the “Change admin password” 
screen. 

You can also enter your first name, last name and email address. 
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It’s highly recommended that you copy your new password and 
save it to a safe place. If you forget the password, there is no way to 
restore it and you won’t be able to access the EasyMail7 Server. 

Click on “I copied my password. Please close this form” button. 
Be sure to save your password to a place where you can easily find it. 

 
Login again using your new password. You become the 

SuperAdmin. As SuperAdmin, you can manage the EasyMail7 Server 
and server backups, manage users and workplaces, assign users to 
workplaces, create contact groups, messages and send messages to 
groups. 
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Workplace Sending Limitations 

G-Lock EasyMail7 automatically creates 1 user (SuperAdmin) and 
1 workplace. A workplace includes email server accounts, email 
templates and drafts, sent items, contact groups (internal and external 
lists), scheduler and Bounce Handler settings.  

As SuperAdmin, you can set sending limitations for the workplace 
such as a monthly sending limit and maximum sending slots to control 
the server load. 

Click on the “Workplace” menu on the program window.  

 

 
Click on “Manage Users/Workplaces”. 
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Click on "Manage Workplaces". 

Click on "Connect". 

Enter your SuperAdmin user name and new password. 

Click OK. 
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Select the workplace and click “Edit”. Here you can change the 
workplace name and description and set email sending restrictions.  

Click OK to save the changes. 
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Add User 

If your license allows, as SuperAdmin you can create multiple 
users who can connect from the EasyMail7 Client on their computers 
to the EasyMail7 Server and work with the program. 

To add a new user: 

1. Navigate to "Workplace" -> "Manage Users/Workplaces" -> 
"Manage Users".  

2. Enter the EasyMail7 Server address. 

3. Click on "Connect". 

4. Enter your SuperAdmin user name and password. 

5. Click OK. 

6. Click "Add New". 

7. Enter the user's information: user name, password, first name, 
last name, email, group and expiration date (valid till – after this date 
the user will be able to use the program only as “Guest”). 

The following user’s groups are available: 

Admin can add, edit and delete users and workplaces, assign 
users to workplaces, manage contact groups, create and 
send messages. 
 

User can manage contact groups, create and send messages 
within the workplaces assigned to him by Admin or 
SuperAdmin. 
 

Guest can use the program in the "read-only" mode, cannot add, 
delete or modify any data inside the program. 

 

8. Click OK to add the user. 
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Add Workplace 

A workplace includes email server accounts, email templates and 
drafts, sent items, contact groups (internal and external lists), and 
Bounce Handler settings. 

If your license allows, you can login as SuperAdmin or Admin and 
create multiple workplaces on the EasyMail7 Server. 

To add a new workplace: 

1. Go to "Workplace" -> "Manage Users/Workplaces" -> "Manage 
Workplaces". 

2. Enter the EasyMail7 Server address. 

3. Click on "Connect" and login with your "SuperAdmin" or 
"Admin" user name and password. 

4. Click OK. 

5. Click "Add New". 

6. Enter the workplace name, description and sending limitations.  
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If you have multiple workplaces, you may need to set sending 
limitations for each workplace to control the server load. 

Maximum sending slots maximum number of messages the user 
can send simultaneously from this 
workplace 
 

Monthly sending limit maximum number of messages the user 
can send per month from this workplace 

 

7. Click OK to add the workplace. 
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Note: the more users/workplaces you have on the EasyMail7 
Server, the more resources the program consumes and the more 
powerful machine for the EasyMail7 Server you must have. 
 

Assign User to Workplace 

After you added a new user and/or workplace, you must assign 
the user to the workplace(s), i.e. grant the user access to one or more 
workplaces.  

You can assign one or multiple users to the same workplace.  

Multiple users can work with the same workplace either 
simultaneously or at different time.  

Each user has the full control under the workplace(s) he is 
assigned to.   
 
To assign a user to a workplace: 

1. Click on “Manage Workplaces”. 

2. Select the workplace. 

3. Select the user in the "All Users" panel. 

4. Click "Add". 
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Connect to EasyMail7 Server  
within Local Network 

After you created users/workplaces and assigned users to 
workplaces, users can connect to the EasyMail7 Server from their 
computers and work with the program within assigned workplaces. 
 

The user must install only the EasyMail7 Client component on 
his/her computer. The installation of the EasyMail7 Server on the 
user’s computer is not required. 
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After the installation, the user starts the EasyMail7 Client and 
enters his login information to connect to the EasyMail7 Server: 
 

 

 

EasyMail7 Server: computer’s name where the EasyMail7 Server is 
installed, for example John-PC 
 

Port: 50888 
 

User Name: user name set by Admin 
 

Password: password set by Admin 
 

After the user logged into the EasyMail7 Server, the user must 
choose the workplace to work with. 

If the user is granted access to one workplace only, the workplace 
will open automatically. 
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Get Started 

Login to the EasyMail7 Server and click on the Workplace menu 
at the top left corner of the program window. 

Navigate to the “Get Started” section. 
 

Follow 4 quick steps to send your first message with G-Lock 
EasyMail7:  
 

Step 1. Add Outgoing Mail Account 

The first step is to create an email server account where you will 
enter your sender information and SMTP settings. 

Click on “Add Outgoing Mail Server Account” in the “Get Started” 
section. 
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Enter your sender information: 

Account Name Name for your account in G-Lock EasyMail7 (will not 
be shown anywhere in the message) 
 

From Name Will show up in the recipient's email as the person 
who sent the message 
 

Email Address Email address from which you will send emails. It 
must be a valid email address. When you enter the 
email address, it repeats throughout the form. 
 

Reply E-mail Address Email address that you want the replies to go to. If 
you do not enter a different email address into this 
field, the replies will be sent to the email address, 
from which you send them. 
 

Bounce (Return) E-mail 
Address 

Email address, to which you will receive bounce 
(returned) email messages. If you do not enter a 
different email address into this field, bounce 
messages will be returned to your "From" email 
address.  
 

Organization Specifies the name of your group, company or 
organization (not required)
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Set the throttling options if necessary: 

Messages per hour Indicates how many messages the program can 
send per 1 hour from this account. The free version 
G-Lock EasyMail7 distributes 250 messages evenly 
for 1 hour. 
 

Messages per day Indicates how many messages the program can 
send per 1 day from this account. 
 

Simultaneous SMTP 
connections 

Indicates how many messages the program can 
send simultaneously from this account. The 
maximum number of simultaneous messages is 
specified by admin in the Workplace options. 

  
To comply with the CAN-SPAM law, you must process bounce 

emails after each sending and delete or unsubscribe them in your list. 

To quickly add your Bounce Email Address to the Bounce 
Handler in G-Lock EasyMail7, click on “Add to Bounce Handler” button. 
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Enter your mail server address, password and other required 
information in the Bounce Account settings. 

Select the action what the program will do with bounce emails: 
delete from contact groups or unsubscribe in all groups. 

Click “Test” to check if your settings are correct. 

Click OK to save the Bounce Account settings. 
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After you add the Bounce Account Settings, click on the Delivery 
Options tab in the Outgoing Email Account. 

G-Lock EasyMail7 supports several sending modes but the most 
popular one is sending via SMTP server. G-Lock EasyMail7 can send 
emails through any 3rd party SMTP server. It can be your dedicated 
SMTP server, or SMTP server of your Internet service provider (ISP).  

In addition to that, you can use the SMTP settings of any 3rd party 
email sender such as Mandrill, SendGrid, Amazon SES and others. 

To send emails through the SMTP server, select the “Send via 
SMTP Server” delivery option. 

Enter the SMTP server information:  

SMTP Server Enter the SMTP server name into this field. Some 
SMTP servers are predefined in G-Lock EasyMail7 
so you can choose the SMTP server from the menu. 
If you use your ISP SMTP server, it usually reads 
something like mail.your-isp.com or smtp.your-
isp.com.  
 

Port Enter the port number. The default port is 25. 
 

Security protocol Select the security protocol if your SMTP server 
requires secure connection: Default (no SSL), 
STARTTLS or SSL. 
 

My Server Requires 
Authentication 

Check this option if your server requires 
authentication and enter your login and password. 
 

Use POP3 
Authentication 

Check this option if your SMTP server requires a 
POP3 authentication and enter your POP3 server 
name, port number (usually 110), your login, and 
password. POP3 authentication means that you must 
connect to the POP3 server to be allowed to send 
the emails. As soon as you do it, the ISP opens you 
a "window" for some time during which you can send 
the messages. 
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To test the account, click on the "Test" button.  

Enter a test email address and click OK. 

 

If the SMTP settings are correct, you will receive an email 
message saying that your SMTP settings are correct.  

If the SMTP settings are not correct, the program will show you 
the error log. Fix the problem and test the SMTP settings again. 

When the test passes, click OK to save the account settings. 
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Step 2. Create Contact Group 

Now you can go to the second step and create a contact group. 
G-Lock EasyMail7 allows you to create a group and load contacts at 
one go without the need to use the import wizard, and create a direct 
link to your contact database without importing the recipients into the 
program. 

Create Group from File 

Navigate to the “Get Started” section and click on “Add Group and 
Import Recipients”.  

Select the option depending on the format of the file/database you 
want to load the contacts from.   

Note: to import groups from G-Lock EasyMail v6.xx, select “from 
G-Lock EasyMail 6”. The EasyMail7 Client must be installed on the 
same computer where G-Lock EasyMail v6.xx is installed. 
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Select the file on the disk and click “Open”. 

Enter a group name. By default the program uses the file name as 
the group name. 

Put the check marks for the fields that you want to import into the 
group and do the field mappings. If the field names in your file match 
the field names in G-Lock EasyMail7, these fields will be mapped 
automatically. 

If the field names in the file do not match the field names in G-
Lock EasyMail7, map the fields manually by choosing the right field 
name from the drop down menu in the "EasyMail Field" column.  

The field containing the email address is required for mapping. 
Other fields are optional. 
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Important! If there is a field with the subscription status in your 
file and you want to import it, map this field to the EasyMail7 
“Subscribed” field and type the subscribed status in the “Format” field. 
For example, if the subscribed status is “Confirmed” in your file, type 
“Confirmed” in the “Format” field. The program will import subscribed 
users with the status 1 and unsubscribed users – with the status 0.  

If you map the field with the subscription status to the EasyMail7 
“Subscribed” field and leave the “Format” field empty, the program will 
import all users with the status 0 (unsubscribed). 

If you do not have a field with the subscription status in the file or 
do not map this field during the group creation, the program will import 
all users with the status 1 (subscribed). 

If you have a field with the subscription date/time in the file and 
want to import this field, map this field to the EasyMail7 
“Subscribe_Date” field and select the correct date format in the 
“Format” field. The date format must match the date format in your file. 

After the fields are mapped, click “Create”. 
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Important! If you have a Windows 64-bit system or installed the 
EasyMail7 Server on a clean machine without Microsoft Office, then 
you must download “Microsoft Access Database Engine 2010 
Redistributable” (AccessDatabaseEngine.exe) for 32-bit systems from 
http://www.microsoft.com/en-us/download/details.aspx?id=13255 and 
install it in the passive mode to be able to create groups directly from 
MS Access, MS Excel 97-2003, or MS Excel 2007-2013 files.  

Go to Start -> Run. 

Type the local path to AccessDatabaseEngine.exe /passive 

Example: D:\temp\AccessDatabaseEngine.exe /passive 

Click OK. 



31 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

Connect Directly to the Database 

Another option to create a contact group is create a link directly to 
the contact database without importing the recipients into G-Lock 
EasyMail7. You create the link only once and the program will always 
read an up-to-date email list from the database. 

To create a link to the database, click on “Connect Directly to 
Your Contact Database” button in the “Get Started” section. 
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From G-Lock EasyMail7, you can connect to an MS Access, MS 
Excel 97-2003, MS Excel 2007-2013, MS SQL, MySQL, CSV file and 
WPNewsman lists in WordPress. Read more about G-Lock 
WPNewsman here http://wpnewsman.com  

 

Step 3. Add Bounce Email Account 

If you have already added the account to process returned emails 
when you were creating an outgoing email account at the 1st step, skip 
this step.  

If not, click on “Add Bounce Email Account” button and enter your 
incoming mail server settings. 

 

Step 4. Create and Send Message 

After you added an outgoing email server account and contact 
group, you can go to the next step and create and send an email 
message. 

Create Message 

The quickest way to create the message is by using a template 
from the program’s template store. G-Lock EasyMail7 includes a rich 
collection of professionally designed responsive HTML email 
templates. 

Click on the “Mail” tab at the left pane. 

Click on "Template Store" under the Home menu. 

Choose the template and click on "Download template”. 
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When the template is installed, close the Template Store and click 
on “Templates” at the left pane. Hover the mouse over the template 
name and click on “Create new message”. 
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The message editor will open where you can customize the 
message as you need by adding your company name, message text, 
merge fields etc. 

In addition, you can load the message from a HTML file, Zip file, 
EML file or web page.  

Click on the “New Message” button under the Home menu. 

Type the message text in the "Edit Message" window, or click on 
the File menu and select "Load Web Page", "Load HTML File", "Import 
Template" or "Import from EML File" option depending on where you 
want to load the message from.  

 

You can fully customize the message using the HTML options 
and Merge menu. 
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Check Message Spam Score 

Before you send the message, it's a good idea to check its spam 
score.  

G-Lock EasyMail7 has the built-in SpamAssassin filter that uses a 
diverse range of tests to identify spam. The filter analyzes the email 
header and body to determine its spam score. 

To check your message against SpamAssassin, click on the 
"Spam Check" button on the menu bar. 
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If your score is less than 5.0, it is OK to send the email.  

If the spam score is more than 5.0, make the corrections 
according to the spam test report to avoid deliverability problems.  

The common reasons for a high spam score are: too many 
images and few text, embedded images, spam trigger words (viagra, 
etc.), mismatch of the message Subject in the header and HTML 
source, links from blacklisted domains. 

If your spam score is acceptable, click "Close" and send a test 
message. 
 

Send Test Message 

It's highly recommended that you send a test message to yourself 
to check if it looks well in the email client when received.  

You can create a group with your test email addresses and 
always use that group for sending a test message before each 
campaign.  

Or, you can send a quick test message to one or several email 
addresses using the “To email” field.  

To send a test email message:   

Select the account in the “From” field. 

Type the message “Subject”. 

Click "Send". 

Select “Test” from the "Send" button menu. 
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On the "Send Test Email" window select the option "To email:" or 
"Group:". 

The "To email:" option allows you to quickly send a test message 
to one or several email addresses without adding them to the group.  

Email addresses must be separated by commas or semicolons. 

Important! When you send a test email using the "To email" field: 

1. the Global Exclusion List does not work (if the email address is 
on the Global Exclusion List, the test message will still be sent to that 
email); 

2. group merge tags in the email do not work. Only the merge 
tags from the Workplace Settings such as the unsubscribe link and 
social links work. 
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 If you have a group with test email addresses, select the "Group:" 
option and then select your test group from the menu. 

You can add email addresses to which you do not want to send 
the test email to the Exclusion list by using the > button. 

Click "Send". 
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Check mail on your test email addresses to see how the message 
displays. If any corrections are needed, you can make them now and 
re-send a test message. 
 

Send Message to the Group 

Select the group in the “Group” field. 

Click “Send”. 

Select “Immediately” from the “Send” button menu. 

Check the "Send report after sending is finished" option if you 
want to receive the PDF report at your email address. The report will 
be sent at your "From" email address.  
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The report will NOT be sent if your "From" email address is on the 
Global Exclusion List or if the message will be sent by an 
autoresponder. 

Click “Send”. 

 

 

Note: if you have duplicate email addresses between groups and 
send the message to more than one group at a time, the program does 
not send the message to all duplicate addresses. The message is sent 
only to the first email address that occurs. 

When you send the message to a database and have duplicate 
addresses in the database, the message is sent to the first email 
address out of duplicate emails that occurs in the database. 
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You can watch the sending process in the Outbox. This is where 
sent emails are stored. 

After the sending is complete, you can click on “View Log” and 
look at the general sending log of the message. 

In addition, you can click on “Processed”, “Sent” and “Failed” to 
look at processed emails (sent + failed), sent and failed (not sent) 
emails. 

 

 

Work with G-Lock EasyMail7 Web Client 

G-Lock EasyMail7 has built in Web Service and offers a RESTful 
interface for consuming JSON content via AJAX or mobile clients.  

We included the basic demo web client into the program 
installation which shows how to create a RESTful JavaScript client. 

In the current version of the web client you can: 

- compose an email message from a template or draft;  

- compose an email message from scratch;  

- send an email message to one or several groups;  
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- save an email message as a draft;  

- edit and delete templates and drafts;  

- view contacts in internal and external groups (databases);  

- view sent emails in the Outbox. 

The current version of G-Lock EasyMail7 web client does not 
allow you to create email server accounts, add contact groups, create 
links to databases, or handle bounce and unsubscribe emails. 

You can login into the web client in any browser on any device 
including iPad, Android tablet pc, Windows tablet pc etc. and run an 
email campaign, check how the email campaign was sent, look 
through the contacts or simply check the data you have on the 
EasyMail7 Server. 

 

Install G-Lock EasyMail7 Web Client 

You can optionally install G-Lock EasyMail7 web client when you 
are installing G-Lock EasyMail7. 

To install G-Lock EasyMail7 web client: 

1. Check the "Install Web Client" option during the setup process. 

2. Click “Next”.  
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3. Finish the setup process. 

 

Login into Web Client 

After you installed G-Lock EasyMail7 web client, you can login 
into it in your browser. 

To login into G-Lock EasyMail7 web client: 

1. Open the URL http://[EasyMail7 Server IP]:50888/wps/www in 
the browser 

Replace [EasyMail7 Server IP] in the URL with the IP address, or 
computer name, or domain name where the EasyMail7 Server is 
installed. Example: http://127.0.0.1:50888/wps/www 

2. Login with your user name and password. 
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3. Click "Sign in". 

4. After you login, select the workplace you will work within. 
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Compose and Send Message 

In G-Lock EasyMail7 web client you can compose an email 
message from scratch or from an existing template, but you cannot 
import the message from a file or web page. 

To compose and send a message: 

1. Click on the "Compose" button to create a new email from 
scratch.  

Or, click on "Templates" at the left side, select a template and 
click on "Create New Message". 

 

 

2. Use the options of the HTML editor to compose the message. 
Or, you can click on "Source" and copy-paste your HTML source. 
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Important! In the web client you cannot use the Merge menu. To 
merge the contact's data, unsubscribe link or social links into the 
message, type the correct merge tags manually. 

3. Select the email server account in the From menu. 

4. Select the group(s) in the To field. If you select more than one 
group, the program shows just the number of groups, for example, 2 
groups, instead of the groups names. 

5. Click "Send Now". 
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You can watch the sending process in the Outbox. 

Click on "View Log" to see the general sending log. 

Click on "Processed", "Sent" and "Failed" to see processed, sent 
and failed emails. 

Click the "Start Sending" button to re-send failed emails. 

 

 

Edit and Delete Templates 

In G-Lock EasyMail7 web client you can edit and delete existing 
templates but you cannot import new templates from files or template 
store, or create templates categories. 

To edit a template: 

1. Click on "Templates" at the left side. 

2. Click on the template category under "Templates" if you want to 
edit a template from the category. 

3. Click on "Edit Template" under the template name. 

4. Make the changes to the template and click "Save".    



48 
To learn more about G-Lock EasyMail7, visit http://easymail7.com 

To delete a template: 

1. Click "Delete" under the template name. 

 

Edit and Delete Drafts 

In G-Lock EasyMail7 web client you can create a message and 
save it as a draft. 

To edit a draft: 

1. Click on "Drafts" at the left side. 

2. Click on "Edit Message" under the draft name. 

3. Make the changes to the draft and click "Save".  

Or, click "Send Now" to send the message immediately.  
 

To delete a draft: 

1. Click "Delete" under the draft name. 

 

View Contacts in Groups and Databases 

In G-Lock EasyMail7 web client you can only view the contacts in 
internal groups and databases. You cannot create new groups or links 
to databases.  

Neither can you edit, delete, add new contacts to the group or 
manage the exclusion list.    

To view contacts: 

1. Switch to the "Contacts" tab. 
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2. Click on the group name or database link name. 
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Useful Articles 

Before you start composing and sending an email message, 
please, read these articles on our website: 

“How to Save Money and Speed up Message Sending with G-
Lock EasyMail7” http://easymail7.com/how-to-speed-up-message-
sending/ 

“How to Insert Picture into the Email Template” 
http://easymail7.com/tutorials/insert-picture-email-template/ 

From these articles you will learn how to re-size, crop and 
compress images directly in G-Lock EasyMail7 before inserting them 
into the message and how to upload images to your web server in 
order to decrease the message size, speed up sending and save your 
money if you are paying for traffic with your email service provider like 
Amazon SES. 

 

Support & Contact 

G-Lock EasyMail7 has a support page at 
http://easymail7.com/contact-support/ where you can ask for a solution 
to your problem using the contact form. We usually reply within 24 
hours on business days. 

Also you can contact us via email at support@glocksoft.com or 
via a live online chat on our main website http://www.glocksoft.com. 
The chat is available on business days during our working hours 10:00 
– 18:00 +3GMT. 
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